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INSTALL LICENSE AGREEMENT

This legal document is an agreement between you, the
end user (“YOU” or “LICENSEE”), and BIAS, Inc.  BY
CLICKING “INSTALL” ON THE FOLLOWING DIALOG,
YOU ARE AGREEING TO BECOME BOUND BY THE
TERMS OF THIS AGREEMENT, WHICH INCLUDES THE
SOFTWARE LICENSE AND THE SOFTWARE DIS-
CLAIMER OF WARRANTY (collectively the “Agreement”).
CLICK “QUIT” ON THE FOLLOWING DIALOG IF YOU
DO NOT ACCEPT THE TERMS OF THIS AGREEMENT.
THIS AGREEMENT CONSTITUTES THE COMPLETE
AGREEMENT BETWEEN YOU AND BIAS, INC.  IF YOU
DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
DO NOT USE OR REGISTER THE SOFTWARE AND
PROMPTLY RETURN THE SOFTWARE AND THE OTHER
MATERIALS (INCLUDING WRITTEN MATERIALS,
BINDERS OR OTHER CONTAINERS) THAT ARE PART OF
THIS PRODUCT TO THE PLACE WHERE YOU
OBTAINED THEM FOR A FULL REFUND.  YOUR USE OF
THIS SOFTWARE SHALL CONSTITUTE ACCEPTANCE OF
THIS AGREEMENT, AND ONCE YOU HAVE REGISTERED
THE SOFTWARE YOU MAY NOT RETURN IT.  

BIAS SOFTWARE LICENSE

1.  GRANT OF LICENSE.  In consideration of payment of
the license fee, which is part of the price you paid for this
product, BIAS, as Licensor, grants to you, LICENSEE, a
nonexclusive license to use and display this copy of a
BIAS software program (the “SOFTWARE”) and accom-
panying user documentation (“DOCUMENTATION”).
LICENSEE may install and use the SOFTWARE on only
one COMPUTER at one time, and such SOFTWARE may
be used by only one user at a time.  BIAS reserves all
rights not expressly granted to LICENSEE.
2.  AUTHORIZATION KEY.  You must register this SOFT-
WARE within 14 days of installation either online
(http://www.bias-inc.com/support/register/), via fax (+1
707-782-1874), or phone (+1 707-782-1866). If the
SOFTWARE has not been registered within 14 days of

installation, it will cease to function until registered.
Once registered, you cannot return the SOFTWARE.  
3.  OWNERSHIP OF SOFTWARE AND DOCUMENTA-
TION.  As LICENSEE, you own the media on which the
SOFTWARE and DOCUMENTATION are originally or sub-
sequently recorded or fixed, but BIAS retains title and
ownership of the SOFTWARE and DOCUMENTATION
and all subsequent copies of the SOFTWARE and DOCU-
MENTATION, regardless of the form or media on which
the original and other copies may exist.  This License is
not a sale of the original SOFTWARE or any copy or sale
of the original DOCUMENTATION.
4.  COPY RESTRICTIONS.  This SOFTWARE and the
DOCUMENTATION are copyrighted.  Unauthorized
copying of the SOFTWARE, including SOFTWARE that
has been modified, merged, or included with other soft-
ware, or of the DOCUMENTATION is expressly forbid-
den.  You may be held legally responsible for any copy-
right infringement that is caused or encouraged by your
failure to abide by the terms of this License.  Subject to
these restrictions, and if the SOFTWARE is not copy-pro-
tected, you may make one (1) copy of the SOFTWARE
solely for backup purposes.  You must reproduce and
include the copyright notice on the backup copy.
5.  USE RESTRICTIONS.  As the LICENSEE, you may phys-
ically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only
one computer at a time.  You may not electronically
transfer the SOFTWARE from one computer to another
over a network.  You may not distribute copies of the
SOFTWARE or the DOCUMENTATION to others.  You
may not modify, adapt, translate, reverse engineer,
decompile, disassemble, or create derivative works based
on the SOFTWARE.  You may not modify, adapt, trans-
late, or create derivative works based on the DOCUMEN-
TATION without the prior written consent of BIAS.
6.  TRANSFER RESTRICTIONS.  This SOFTWARE is
licensed only to you, LICENSEE, and may not be assigned
or otherwise transferred to anyone, whether voluntary
or by operation of law, without the prior written consent
of BIAS.  Any authorized transferee of the SOFTWARE
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must agree to be bound by the terms and conditions of
this Agreement, or the transfer shall be invalid.  In no
event may you transfer, assign, rent, lease, sell, or other-
wise dispose of the SOFTWARE on a temporary or per-
manent basis except as expressly provided herein.
7.  LICENSE TO U.S. GOVERNMENT.  If LICENSEE is an
agency or instrumentality of the United States
Government, the SOFTWARE and DOCUMENTATION
are “commercial computer software” and “commercial
computer software documentation”, and pursuant to
FAR 12.212 or DFARS 227.7202, and their successors, as
applicable, use, reproduction and disclosure of the
Software and Documentation are governed by the terms
of this Agreement.  
8.  TERMINATION.  This License is effective until termi-
nated.  This License will terminate automatically without
notice from BIAS if you fail to comply with any provision
of this License.  Upon termination you shall destroy the
DOCUMENTATION and all copies of the SOFTWARE,
including modified copies, if any.  
9.  UPDATE POLICY.  BIAS may create, from time to time,
updated versions of the SOFTWARE.   At its option, BIAS
will make such updates available to LICENSEE and trans-
ferees who have paid the update fee and returned the
registration card to BIAS.
10.  BIAS PRODUCT SUPPORT.
Unlimited Complimentary Self Help Options
If you have questions about installing or using your BIAS
products, please check the manual or user guide first,
you will find answers to most of your questions there. If
you need further assistance, please check: 
http://www.bias-inc.com/support.html 
for frequently asked questions, an extensive database of
related articles, troubleshooting tips, and more.
Limited Complimentary Technical Assistance
Ninety days of technical support assistance for up to
three incidents is available with the initial purchase of
Type 1 BIAS products (Peak, Deck, SoundSoap Pro).
Ninety days of technical support assistance for a single
incident is available with the initial purchase of Type 2

BIAS products (Peak DV, Peak LE, Deck LE, SuperFreq,
SoundSoap 2). Type 3 products (OEM versions) are
excluded. Thirty days of technical support assistance for
a single incident is available with the purchase of paid
upgrades to Type 1 and Type 2 BIAS products. The sup-
port period begins when the product authorization code
(PAC) is initially issued following the product registra-
tion. To receive e-mail or telephone technical support,
you will need a valid serial number and must be regis-
tered for a current BIAS product. Please keep your origi-
nal product serial number and PAC in a safe place as it
will be required for support.  For customers preferring e-
mail assistance, please use the email form available on
our web site at:  http://www.bias-inc.com/support.html
Or, email:  support@bias-inc.com
For customers preferring telephone assistance, (connect
and toll charges apply), please have your computer run-
ning and close by the phone and call us at:  
+1-707-782-1865 
(9AM-5PM Monday-Friday PST – excluding BIAS holidays)
Fee-based Technical Support Options
Fee-based Support is available for those customers
whose support period has expired or for Type 3 (OEM
version) customers.  Please call:  
+1-707-782-1865  
(9AM-5PM Monday-Friday PST – excluding BIAS holidays)
For customers living outside of North America, please
contact your local BIAS distributor, or contact BIAS
directly. A list of BIAS distributors may be found at:  
http://www.bias-inc.com/distributors.html
BIAS Support Policy and Hours
BIAS, Inc. support policy and hours are subject to change
without notice.
Sales and Non-Technical Customer Service
For product information, sales, and other non-technical
customer service, please email or call:  
sales@bias-inc.com
US: 1-800-775-BIAS (2427)
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International: +1-707-782-1866  
(9AM-5PM Monday-Friday PST – excluding BIAS holidays)
No technical support is available at the numbers or email
address above.
11.  MISCELLANEOUS.  This Agreement is governed by
the law of the State of California.
DISCLAIMER OF WARRANTY AND LIMITED WARRANTY
THE SOFTWARE AND DOCUMENTATION (INCLUDING
INSTRUCTIONS FOR USE) ARE PROVIDED “AS IS”
WITHOUT WARRANTIES OF ANY KIND.  FURTHER, BIAS
DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REP-
RESENTATIONS REGARDING THE USE, OR THE
RESULTS OF THE USE, OF THE SOFTWARE OR DOCU-
MENTATION IN TERMS OF CORRECTNESS, ACCURACY,
RELIABILITY, CURRENTNESS, OR OTHERWISE.  THE
ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE
OF THE SOFTWARE IS ASSUMED BY YOU, AND NOT
BIAS OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR
EMPLOYEES, YOU AGREE TO ASSUME THE ENTIRE
COST OF ALL NECESSARY SERVICING, REPAIR, OR COR-
RECTION.
BIAS warrants to the original LICENSEE that the media
upon which the SOFTWARE is recorded and the BIAS
Key (USB dongle), if applicable, are free from defects in
materials and workmanship under normal use and serv-
ice for a period of ninety (90) days from the date of deliv-
ery as evidenced by a copy of your receipt.  Further, BIAS
hereby limits the duration of any implied warranty(ies)
on the media to the respective periods stated above.
Some states do not allow limitations on duration of an
implied warranty, so the above limitation may not apply
to you.
BIAS’ entire liability and your exclusive remedy as to the
media shall be, at BIAS’ option, either (a) return of the
purchase price or (b) replacement of the media that
does not meet BIAS’  Limited Warranty and which is
returned to BIAS with a copy of the receipt.  If failure of
the media has resulted from accident, abuse, or misappli-
cation, BIAS shall have no responsibility to replace the
media or refund the purchase price.  Any replacement
media will be warranted for the remainder of the original

warranty period or thirty (30) days, whichever is longer.
THE ABOVE ARE THE ONLY WARRANTIES OF ANY
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE, THAT ARE MADE BY BIAS CONCERNING THE
BIAS PRODUCT.  NO ORAL OR WRITTEN INFORMATION
OR ADVICE GIVEN BY BIAS, ITS DEALERS, DISTRIBU-
TORS, AGENTS, OR EMPLOYEES SHALL CREATE A WAR-
RANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH
INFORMATION OR ADVICE.  THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS.  YOU MAY HAVE OTHER
RIGHTS WHICH VARY FROM STATE TO STATE.
NEITHER BIAS NOR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR
DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR
ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCI-
DENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS
OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, AND THE LIKE)
ARISING SUCH DAMAGES.  BECAUSE SOME STATES DO
NOT ALLOW THE EXCLUSION OR LIMITATION OF LIA-
BILITY FOR CONSEQUENTIAL OR INCIDENTAL DAM-
AGES, THE ABOVE LIMITATION MAY NOT APPLY TO
YOU.

This Disclaimer of Warranty and Limited Warranty is gov-
erned by the laws of the State of California.

Should you have any questions concerning this
Agreement, or if you desire to contact BIAS for any rea-
son, please contact in writing: 

BIAS Customer Sales and Service
1370 Industrial Ave.
Suite A
Petaluma, CA 94952
USA
Copyright 1996–2004 BIAS, Inc.
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BIAS Product Support:

Unlimited Complimentary Self Help
Options

If you have questions about installing or using your BIAS
products, please check the manual or user guide first,
you will find answers to most of your questions there. If
you need further assistance, please check:

http://www.bias-inc.com/support.html

for frequently asked questions, an extensive database of
related articles, troubleshooting tips, and more.

Limited Complimentary Technical
Assistance

Ninety days of technical support assistance for up to
three incidents is available with the initial purchase of
Type 1 BIAS products (Peak, Deck, SoundSoap Pro).
Ninety days of technical support assistance for a single
incident is available with the initial purchase of Type 2
BIAS products (Peak DV, Peak LE, Deck LE, SuperFreq,
SoundSoap 2). Type 3 products (OEM versions) are
excluded. Thirty days of technical support assistance for
a single incident is available with the purchase of paid
upgrades to Type 1 and Type 2 BIAS products. The sup-
port period begins when the product authorization code
(PAC) is initially issued following the product registra-
tion. To receive e-mail or telephone technical support,
you will need a valid serial number and must be regis-
tered for a current BIAS product. Please keep your origi-
nal product serial number and PAC in a safe place as it
will be required for support.  For customers preferring

e-mail assistance, please use the email form available on
our web site at:

http://www.bias-inc.com/support.html

Or, email:

support@bias-inc.com

For customers preferring telephone assistance, (connect
and toll charges apply), please have your computer run-
ning and close by the phone and call us at:

+1-707-782-1865

9AM-5PM Monday-Friday PST – excluding BIAS holidays

Fee-based Technical Support Options

Fee-based Support is available for those customers
whose support period has expired or for Type 3 (OEM
version) customers.  Please call:

+1-707-782-1865

9AM-5PM Monday-Friday PST – excluding BIAS holidays

For customers living outside of North America, please
contact your local BIAS distributor, or contact BIAS
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directly. A list of BIAS distributors may be found at:

http://www.bias-inc.com/distributors.html

BIAS Support Policy and Hours

BIAS, Inc. support policy and hours are subject to change
without notice.

Sales and Non-Technical Customer
Service

For product information, sales, and other non-technical
customer service, please email or call:

sales@bias-inc.com

US: 1-800-775-BIAS (2427)

International: +1-707-782-1866

9AM-5PM Monday-Friday PST – excluding BIAS holidays

No technical support is available at the numbers or email
address above.
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Chapter 1:
Introducing SoundSoap 2

Welcome!

Thank you for purchasing BIAS SoundSoap 2!  SoundSoap 2
is a professional-quality noise reduction solution that’s very
easy to use. By adjusting just a few controls, anyone can
remove unwanted hiss, room noise, rumble, electrical hum,
clicks & crackles, and other background noise from almost
any digital media file – including digital video (DV) sound-
tracks, PowerPoint and other presentation software sound-
tracks, Flash and other web-tool soundtracks, digital audio
workstation tracks, cassette or other analog tape recordings,
or vinyl recordings that have been transferred to a comput-
er, and other sources. SoundSoap 2 was designed by listen-
ing to the suggestions of audio and video editors who all had
one thing in common – noisy media, and the desire to clean
it up quickly and easily.

SoundSoap 2 Features:

• Broadband noise reduction/removal

• 50 & 60 Hz hum reduction/removal

• Rumble reduction/removal

• “Learn” function – allows automatic noise reduc-
tion/removal

• “Preserve Voice” function – specialized pre-filtering
for voice-based media files

• Click & Crackle reduction/removal

• Enhance Slider – allows tone enhancement when
working with degraded media sources, such as old
audio or video cassettes or vinyl records

• A real-time plug-in which may be used with any
Mac OS X-compatible VST, RTAS, or Audio Units
host application, or any Windows XP-compatible
VST, RTAS, or DirectX host program

• A stand-alone edition – for users who do not own
a compatible host program

Who is SoundSoap 2 designed for?

SoundSoap 2 is designed for a wide variety of users, rang-
ing from home movie makers to audio engineers and
video editors. SoundSoap 2’s advanced noise reduction
algorithm and simple user interface shatter the myth that
noise reduction software must be complicated, with
dozens of parameters to adjust, in order to achieve high
quality noise reduction.  

With just a few knobs, buttons, and sliders, you can learn
how to use SoundSoap 2 in just a few minutes – and
you’ll quickly see why SoundSoap 2 is perfect for anyone
with noisy digital media!
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What’s New in SoundSoap 2?

SoundSoap 2 offers a number of new features and
enhancements, including:

• Updated User Interface

• Click & Crackle Removal/Reduction

• “Enhance” Slider

• Includes RTAS (Mac OS X, Windows XP), and Audio
Units (Mac OS X) versions

• Drag & Drop file support (stand-alone edition)

• Windows Media Support (stand-alone edition)

Minimum System Requirements

To use SoundSoap 2 on a Macintosh – you will need:

• G4 or G5 Apple Macintosh desktop, PowerBook, or
iBook (≥ 400 MHz processor recommended)

• Macintosh OS 10.2 minimum

• Plug-in mode requires compatible VST, Audio
Units, or RTAS host application – such as Peak 4
(contact BIAS for compatibility information)

• QuickTime 6.5 (included)

To use SoundSoap 2 on a Windows PC – you will need:

• Pentium III or Pentium IV desktop or laptop
(≥ 600 MHz processor recommended)

• Windows XP Home or Professional

• Compatible VST, RTAS, or DirectX host program

• Windows Media 9 & QuickTime 6.5 (included)

Both:

• 128 MB RAM minimum

• 20 MB available disk space

For most up-to-date info, please visit:

http://www.bias-inc.com/soundsoap/

About Your User’s Guide

SoundSoap 2 is designed to be simple and intuitive. Your
User’s Guide is designed to help you set up and use
SoundSoap 2 for noise reduction/removal as quickly as
possible.  

This User’s Guide assumes that you are familiar with
standard Macintosh and/or Windows operating tech-
niques, including:

• Setting up, starting, and using your computer

• Choosing commands from menus

• Double-clicking, selecting, shift-selecting, and
dragging with the mouse

• Opening, copying, saving, and deleting files

• Opening, closing, scrolling, moving, re-sizing, and
selecting windows

If you don’t know how to perform these tasks, please
refer to the documentation that was included with your
computer, and spend a little time learning about your
operating system before going any further.  This will
make using SoundSoap 2 much easier and more enjoy-
able.
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The chapters in your SoundSoap 2 User’s Guide are
arranged in the order in which you would typically per-
form tasks to remove unwanted noise from your media.

• Chapter 1 introduces you to SoundSoap 2 and
explains some of the requirements for using it

• Chapter 2 explains how to install, register, and
authorize SoundSoap 2

• Chapter 3 explains the various features in
SoundSoap 2 and how they are used to
reduce/remove noise

• Chapter 4 demonstrates how to use SoundSoap 2
with other software – both as a plug-in and as a
stand-alone program

Conclusion

Now that you know a little about SoundSoap 2, proceed
to the next chapter to learn how to install your software
and get started using it.  

Look for important tips and notes whenever you

see this exclamation mark!
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Chapter 2:

Installing SoundSoap 2

Introduction

SoundSoap 2’s auto-installer software makes installation
very easy.  Your complete SoundSoap 2 system consists
of:

• CD-ROM Installer

• SoundSoap 2 Serial Number and Product
Authorization Code (PAC)

Before you install SoundSoap 2, please check the

Minimum System Requirements on Page 14 of this
User’s Guide.

To install SoundSoap 2 on a Macintosh:

1. If you are using any virus-protection software, turn
it off or temporarily remove it, and restart your
Macintosh.

2. Insert the SoundSoap 2 Install CD-ROM in your
CD-ROM drive, and double-click the Install icon.

3. When the installer dialog appears, read the Read
Me for late-breaking information concerning the
Installer, then click Continue to proceed.

4. Select where you would like to install SoundSoap
2, using the Install Location pop-up menu.

5. Click Install at the bottom right of this dialog.

6. After you have clicked Install, follow the on-screen
instructions.

7. When the installation is complete, a message will
appear indicating that the installation was successful.
Click Quit to quit the Installer (don’t forget to turn
back on any virus-protection software that you may
be using the next time you restart the computer).

What SoundSoap 2 Installs on Macintosh systems:

VST Hosts: (Peak, Cubase SL/SX, Nuendo, etc.)

The VST format plug-in is automatically installed into the
following directory:

/Macintosh HD/Library/Audio/Plug-Ins/VST/

Chapter 2 19

2

The Installer dialog on Mac OS X



Audio Units Hosts: (Peak, Logic, Digital Performer,
GarageBand, SoundTrack, Final Cut Pro, etc.) 

The Audio Units format plug-in is automatically installed
into the following directory: 

/Macintosh HD/Library/Audio/Plug-Ins/Components/ 

RTAS Hosts: (Pro Tools) 

The RTAS format plug-in is automatically installed into
the following directory: 

/MacintoshHD/Library/Application Support/Digidesign/Plug-Ins/

Check the documentation included with your host
application for more information on where it
expects plug-ins to reside, in order to function
properly.

To install SoundSoap 2 on a Windows PC:

1. If you are using any virus-protection software, turn
it off or temporarily remove it, and restart your
computer.

2. Insert the SoundSoap 2 Install CD-ROM in your
CD-ROM drive. If the SoundSoap 2 Setup program
does not automatically launch, double-click the
Install SoundSoap 2 icon.

3. When the Welcome to the SoundSoap 2 Setup pro-
gram window appears, click the Next button.

4. Read the Software License Agreement, and then
click Yes to agree to the terms and continue with
the SoundSoap 2 installation.

5. To install SoundSoap 2 into the default directory

(recommended), click the Next button.

6. In the Setup Type dialog, choose the “Typical”
option, and click the Next button.

7. In the Select Program Folder dialog, click the Next
button to continue with installation.

8. In the Ready to Install dialog, click the Next button
to continue with installation.

9. In the Choose Directory dialog, you will be
prompted to select the VstPlugIns folder for your
VST host program. If you have any Steinberg audio
programs installed, the directory will default to the
Steinberg VstPlugIns folder.

It is recommended that you use this folder as a central
location for all of your VST plug-ins. If you do not have
any Steinberg audio programs installed, select the
VstPlugIns folder for your VST host program and then
click the OK button.

At the end of installation, the installer will give

you the option of registering via the BIAS website,
which you may find more convenient than mail-
ing your registration card.

What SoundSoap 2 Installs on Windows systems:

VST Hosts: (Cubase SL/SX, Nuendo, Wavelab,
Premiere, Audition, etc.)

The VST plug-in is automatically installed into the
VstPlugIns folder for your VST host program.
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DirectX Hosts: (Sonar, Sound Forge, Vegas Video,
Audition, etc.) 

The DirectX format plug-in is automatically installed and
entered into the registry. 

RTAS Hosts: (Pro Tools) 

SoundSoap 2 automatically installs the RTAS format plug-
in into: 

/Program Files/Common/Digidesign/DAE/Plug-Ins/

Authorization

SoundSoap 2 must be authorized to work on your com-
puter.  The SoundSoap 2 authorization system consists of
the following components:

• Serial number (located on the BIAS License Certificate)

• A Product Authorization Code – which is issued at
the end of the registration process

You must register with BIAS in order to obtain your
Product Authorization Code; SoundSoap 2 will not
launch after the 14 day registration period unless
you authorize it with your Serial Number and
Product Authorization Code!

The fastest and easiest way to register SoundSoap 2 –
and receive your Product Authorization Code – is by reg-
istering online, at:

http://www.bias-inc.com/support/register/

The registration/authorization process provides the fol-
lowing services:

• It registers your software with BIAS – making you
eligible for technical support and product updates.

• It provides you with the Product Authorization
Code you will need to authorize SoundSoap 2.

Conclusion

Now that you have installed, registered, and authorized
SoundSoap 2, proceed to the next chapter to learn sev-
eral basic concepts and functions essential to using
SoundSoap 2.
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Chapter 3:

SoundSoap 2 User
Interface & Controls

Introduction

This chapter explains several key SoundSoap 2 concepts
and functions.

A Brief Explanation of Noise Types

If you are using SoundSoap 2, chances are you have run
into some sort of undesirable noise in your digital media.
You may have encountered camera motor noise, picked
up by the built-in microphone in your DV camera – or
perhaps you’ve had an annoying hiss as you archive an
old audio cassette collection – maybe there’s a 60Hz
hum due to a bad cable that was used in a recording.
Perhaps you’re removing clicks and crackles from an old
LP collection to convert to CD, or make compressed files
for use in a portable digital music player.  In any case,
such noises can be a big distraction from the desired
audio signal. It is projects like these that call for the
advanced broadband noise, hum, and rumble reduction,
and click  and crackle reduction offered by BIAS
SoundSoap 2.

While SoundSoap 2 can do a great deal to reduce noise
from a digital file, there may be situations in which the 

desired audio signal is lower than the signal of noise, mak-
ing it impossible to fully remove the noise. In cases like
this, SoundSoap 2 may not entirely remove the noise, but
may be able to significantly reduce its presence.

The types of noise that SoundSoap 2 is designed to
reduce are outlined below:

Broadband Noise

A type of noise that is composed of a broad frequency
spectrum.  Tape hiss, air-conditioner noise, white noise,
and pink noise are common examples of “broadband”
noise.

Hum

A type of noise that is typically composed of a single fre-
quency, such as 60 Hz, and is often associated with audio
equipment being used on faulty electrical circuits, equip-
ment that is not properly grounded, or even electrical
power cables being in close proximity to audio signal
cables.
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Rumble

A type of very low-frequency noise, usually occuring at 40
Hz or below. A good example of rumble would be the
low frequency noise produced by a turntable motor, that
is commonly found in recordings of vinyl records.

Click and Crackle

Clicks and crackles are commonly found in recordings
made from vinyl records.  Clicks are the result of recording
(digitizing) a scratch on a vinyl record, and generally have a
fairly high level (for a very short period of time).  Clicks are
audible in a digital recording because of an abrupt change
in amplitude in the audio waveform in a very short period
of time.  Crackles are similar to clicks, but are caused by tiny
surface imperfections on a vinyl record.  Crackles are lower
in level, and are more densely concentrated than clicks, and
the sound they produce is similar to the sound of some-
thing “sizzling” or “frying” in a frying pan.

Getting Started with SoundSoap 2

SoundSoap 2 can be used as a plug-in within your VST,
Audio Units, RTAS/AudioSuite, or DirectX compatible
host program, on Mac OS X or Windows XP.  

SoundSoap 2 was designed to provide high-quality noise
reduction, while remaining simple to use, with a minimal
number of controls. While there are not many controls
required to quickly clean up noisy media, it is important
to know what each one does, so as to achieve the best
possible results.

The next section introduces the graphical user interface
of SoundSoap 2. Take a moment to familiarize yourself
with the various knobs, buttons, sliders, and displays,
and then move on to the next section, which features
more detailed descriptions on how to use each.

SoundSoap 2 Controls Explained

The SoundSoap 2 GUI (Graphical User Interface) con-
tains the few knobs, buttons, and sliders required to
reduce most types of broadband noise, hum, rumble, or
clicks and crackle from just about any type of digital
media. These controls consist of the following:

Learn Noise Button

SoundSoap 2’s “Learn Noise” feature is what makes it so power-
ful and easy to use. The Learn Noise feature can automatically
determine the noise contained in a file, and automatically set the
values for the Noise Tuner and Noise Reduction controls.  To use
this feature, just click the Learn Noise button with your mouse,
and start playback. SoundSoap 2 will analyze the noise present
in the file, create an appropriate noise profile, and determine the
best settings for the Noise Tuner and Noise Reduction knobs.  It
is important to understand that noise profiles are created
“behind the scenes” and are not visible within the SoundSoap 2
interface.  The next section includes examples of noise profiles.

If your file has an area of just isolated noise, and
none of the music, voice, or other audio you wish to
preserve, use this section for “Learning the Noise”. For
more detail on using the Learn Noise feature, please
refer to Chapter 4: Using SoundSoap 2.
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SoundSoap 2:
Graphical User Interface (GUI)

Remove Click & Crackle Slider

This single slider controls
the threshold level for both
click and crackle reduction.  

(Moving it upwards removes
more clicks and crackles –
moving it downward
removes fewer clicks and
crackles)

Noise Tuner Knob

Helps you “tune in” the hiss and
background noise you want to
remove. (The Learn Noise button
sets this control automatically – or
you can adjust it manually)

Wash Window

Sound Soap’s unique Wash Window
provides a graphical representation
of noise reduction. The left side of
the window shows the unprocessed
audio signal, and the right side
shows the “clean” signal.

Blue = Desired audio signal
Red = Noise

Preserve Voice Button

This is a special pre-fil-
tering mode which
removes frequencies
outside of the range of
the human voice.

Broadband Mode
Selection Controls

Allow you to toggle between
noise reduction being on &
off, and also offers a “noise
only” mode, which allows
you to monitor just the
offending broadband noise,
providing useful feedback
about the frequencies being
removed.

Learn Noise Button

The Learn Noise feature ana-
lyzes an audio signal and deter-
mines the frequencies causing a
broadband noise problem.
Once this “noise profile” has
been determined, Learn Noise
also sets the Noise Tuner and
Noise Reduction knobs automat-
ically.

Remove Rumble Button

Takes out low-frequency
noise at 40 Hz & below –
often found as background
noise in many DV clips.

Remove Hum Controls

Used for eliminating hum
introduced into digital audio
& video files from electrical
interference. Use 60Hz for
regions using 60Hz electri-
cal systems (North/South
America), and 50Hz in
regions using 50Hz systems
(Africa/Asia/Australia/
Europe). *

Noise Reduction Knob

Controls the amount of noise
reduction being applied.
(The Learn Noise button sets
this control automatically – or
you can adjust it manually)

Enhance Slider

The Enhance slider is used
to add  “sparkle” back into
the audio signal.  It can
help to restore frequencies
that may have been lost in
old or degraded media.

*Some regions in these continents use different electrical frequencies – if you’re unsure about the electrical system in the country where you live,
a good resource for checking this is available at:  http://kropla.com/electric2.htm



Noise Tuner Knob

To make a setting with the Noise Tuner, click the knob
with your mouse, and rotate to the left or right. 

The Noise Tuner knob is essentially a threshold control, and
is responsible for determining what is considered to be
noise, and what is considered to be the desired audio signal.
For example, turning the Noise Tuner knob all the way to the
left (counter-clockwise), means setting a very low threshold
value.  With a very low threshold value, all audio content
with an amplitude above this threshold is considered to be
part of the desired audio signal that we wish to preserve.  On
the other hand, setting a higher threshold value with the
Noise Tuner means that any of the audio content with an
amplitude lower than the threshold level will be eliminated.

Another important concept related to the Noise Tuner knob
and the idea of a threshold level is that of a “noise profile”.  If
the threshold determines the level at which some audio con-
tent is desired signal and some is noise, think of the noise
profile as the “shape” of the point where the desired signal
meets the noise.  SoundSoap 2 has the ability to use either a
“flat” noise profile, in which all frequencies are treated equal-
ly – or, if the Learn Noise feature is used, then a custom noise
profile is created that addresses the actual broadband fre-
quencies that happen to be present in a media file.  When
using a learned noise profile, more noise reduction is applied
in the frequency ranges where it is needed.

The Noise Tuner can be used in a variety of ways – first, it can
be set automatically by first using SoundSoap 2’s Learn Noise
feature.  This method is ideal when the media file being

cleaned has an isolated area of the noise by itself.  Learn
Noise first analyzes the frequency content of this portion of
audio, creates a noise profile, and then automatically sets the
Noise Tuner knob to what should be an ideal position.  The
diagram below illustrates this concept.

If we needed to adjust the threshold level, we could just
rotate the Noise Tuner knob – for example, if we rotated
it counter-clockwise, the noise profile would remain
unchanged, but more of the overall audio content would
be considered to be the part we wish to preserve. 

THRESHO LD
LEVEL/NO ISE PROFILE
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This diagram illustrates having a low Noise Tuner setting, with a custom
noise profile – a custom noise profile is the result of having used the
Learn Noise feature – different frequencies are affected in different ways.
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This diagram illustrates having a high Noise Tuner setting, with a custom
noise profile – a custom noise profile is the result of having used the
Learn Noise feature – different frequencies are affected in different ways.
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audio below threshold = noise

audio above threshold = desired signal

audio below threshold = noise

audio above threshold = desired signal



The second way to use the Noise Tuner is to make adjust-
ments without having first “learned” a custom noise profile.
This method is typically used when the media file being
cleaned does not contain an isolated portion of noise by itself.
In some instances, learning a noise profile within a section of
the desired audio signal can cause some frequencies that
should be preserved to be removed, based on the custom
noise profile that’s created.  In cases where there is no isolat-
ed portion of noise by itself, adjusting the Noise Tuner knob
using a “flat” noise profile can often produce better noise
reduction results, as a flat noise profile affects all frequencies
equally.  The diagrams below illustrate using a flat noise pro-
file.

Whether you’re using a learned noise profile or a flat
noise profile, the Noise Tuner knob behaves in exactly
the same way – it simply varies the threshold level.  So,
with a flat noise profile, if we were to rotate the Noise
Tuner knob counter-clockwise it would lower the thresh-
old level, just as in the previous example using a learned
noise profile.

Finally, you can use the Noise Tuner with the listening
mode set to “Noise Only” (see “Broadband Mode
Buttons” later in this chapter).  This method allows you
to tune in and hear just the noisy portion of audio that
you are trying to reduce. When using SoundSoap 2 in
this manner, just turn the Noise Tuner knob until all you
hear (or most of what you hear) is noise.  When you find
the best setting for the Noise Tuner in Noise Only mode,
(the one that allows you to hear the most noise) you
should hear a dramatic difference when you toggle the
listening mode back to the “On” position.  

When Noise Only mode is used, the Wash Window works
“in reverse” – that is, the left side still shows both red and
blue lines, but when the ideal noise reduction settings are
found, only red lines (noise) are displayed on the right side.

Noise Reduction Knob

To make a setting with the Noise Reduction knob, click
the knob with your mouse, and rotate to the left or right.  
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This diagram illustrates having a low Noise Tuner setting, with a flat
noise profile – in this example, all frequencies are affected equally.
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This diagram illustrates having a high Noise Tuner setting, with a flat
noise profile – in this example, all frequencies are affected equally.
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audio above threshold = desired signal
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The Noise Reduction knob works in two ways – first, it
manually adjusts the amount of noise reduction being
applied. As the Noise Reduction knob simply adjusts the
amount of noise reduction being applied, it is very
important to first “tune-in” the offending noise using the
Noise Tuner knob. Once you have found the right setting
to reduce the noise in a particular media file, then you
can use the Noise Reduction knob to adjust how much of
that noise is removed.

The second way to use the Noise Reduction knob is sim-
ilar to the way the Noise Tuner can be used in conjunc-
tion with the Learn Noise button. To use the Noise
Reduction knob in this way, first use the Learn Noise but-
ton to pick up a noise profile from the media file, and
then, based on this profile, use the Noise Reduction
knob to fine tune the amount of noise being reduced.
When using the Learn Noise feature to establish settings,
it is often unnecessary to make any further adjustments
to the Noise Reduction knob.

Wash Window

SoundSoap 2’s unique Wash Window provides a visual rep-
resentation of the noise reduction process. The Wash
Window displays a series of red and blue lines from left to
right within the small oval window in the middle of the
SoundSoap 2 GUI.  A center line divides the oval window
into left and right halves, and indicates the point at which
noise is being reduced.  

Blue lines represent the desired audio, and red lines repre-
sent noise. In addition to the two colors that represent the
desired audio and the noise to be removed, the Wash

Window also shows the strength of each type of signal by
using a darker or lighter shade of each color.  

Ideally, the display will show strong blue and red lines on the
left half of the Wash Window, and only strong blue lines on the
right half of the window – indicating that only the desired
audio is being output, and that any noise has been “cleaned”.

For an example of how the Wash Window works, think of a dig-
ital video clip of someone being interviewed. Imagine a strong,
clear voice – but in the background there is a distinct noise from
the A/C system in the room where the interview is being con-
ducted. With SoundSoap 2’s listening mode set to “Off “, the
Wash Window would display mixed blue and red lines moving
from left to right across the entire display.  With SoundSoap 2’s
listening mode set to “On”, and an ideal combination of noise
tuning and noise reduction, the display should still show mixed
red and blue lines in the left half of the Wash Window, but as the
lines move to the right half of the Wash Window (after having
been processed), only blue lines should appear.

When Noise Only mode is used, the Wash Window works “in
reverse” – that is, the left side still shows both red and blue
lines, but when the ideal noise reduction settings are found,
only red lines (noise) are displayed on the right side.

Remove Click & Crackle Slider

The Remove Click & Crackle slider controls two internal
parameters simultaneously – the click threshold, and the



crackle threshold.  This control is optimized so as to pro-
vide excellent reduction of both types of noise.

When this slider is in its lowest position, it is inactive.
Moving it upwards removes more clicks and crackles –
moving it downward removes fewer clicks and crackles.
The ideal setting for the click and crackle slider will vary
depending on the audio material you are attempting to
restore.  The general rule for this control is to use the
lowest setting possible, which successfully eliminates the
clicks and crackle present in your digital media file.

The Click & Crackle removal slider operates independ-
ently of all other controls.

Enhance Slider

When working with old or degraded media, such as old
audio or video cassettes or old vinyl records, some fre-
quencies may not be present in the digitized version of
the original recording.  For example, this might be
caused by oxidation of the magnetic tape, or the accumu-
lation of microscopic debris in the grooves of a record.
In any case, the Enhance slider is designed to help bring
back the original tone of a degraded recording.

If a media file you’re working with sounds a little “dull”,
use the Enhance Slider to add “sparkle” back into the
audio signal by boosting frequencies that may have been
lost because of degraded media.  As this control is
designed to enhance frequencies and tone, it is recom-

mended that it be used as a final processing step, after
the appropriate settings have been made to remove
noise.  

When this slider is in its lowest position, it is inactive.  For
the best results, leave the Enhance slider inactive until
you have configured all other controls for the best noise
reduction results.  When you have done this, you can
control how much enhancement is applied by moving
this slider.  Moving it upwards applies more enhance-
ment – moving it downward applies less enhancement.

The Enhance slider operates independently of all other
controls.

Preserve Voice Button

To use the Preserve Voice feature, simply click the button
labeled “Preserve Voice” within the SoundSoap 2 inter-
face using your mouse. This button will light up in bright
green to indicate that it is on. To turn Preserve Voice off,
just click the button again.  

The Preserve Voice feature applies a specific set of filters
that remove frequencies outside of the range of the
human voice. This helps in preserving the audio quality
of vocal recordings that may also contain noise.  

If the file includes music or other audio content
besides the human voice (speech, singing, etc.) the

Preserve Voice feature should not be used. 

Chapter 3 31

3



Whether you choose to use the Learn Noise function to
automatically create a noise profile, or use the Noise
Tuner and Noise Reduction knobs to adjust the amount
of noise reduction manually, you should use Preserve
Voice mode when attempting to clean vocal files – such
as narration, singing, or dialogue – where no other audio
is present (musical instruments, etc.).

Preserve Voice mode operates independently of all other
controls, and may be turned on before or after “learning”
a noise profile, and will not affect the accuracy of the
learned noise profile.

Remove Rumble Button

To use the the Remove Rumble feature, simply click the
button labeled “Remove Rumble” within the SoundSoap
2 interface using your mouse. This button will light up in
bright green to indicate that it is on. To turn Remove
Rumble off, just click the button again.  

The Remove Rumble feature applies a specific set of filters
that target the low frequencies responsible for rumble.
Typically, “rumbles” occur at 40 Hz or below.  Rumble is com-
monly found in recordings of vinyl records, where the very
low frequency noise of the turntable motor can be trans-
fered through the turntable’s needle and be picked up in the
recording.  This function helps to preserve the quality of
media affected by rumble.  

Whether you choose to use the Learn Noise function to
automatically create a noise profile, or use the Noise Tuner
and Noise Reduction knobs to adjust the amount of noise
reduction manually, you should use Remove Rumble mode

when attempting to clean media that contains this type of
low-frequency noise.

Remove Rumble mode operates independently of all
other controls, and may be turned on before or after
“learning” a noise profile, and will not affect the accuracy
of the learned noise profile.

Broadband Mode Buttons

The Broadband mode buttons in the SoundSoap 2 inter-
face control whether broadband noise reduction is On,
Off, or in “Noise Only” mode.  To make settings to these
controls, use your mouse to click into the desired mode.
The selected Mode is indicated by an illuminated green
button.  

When the “Off “ button is illuminated, SoundSoap 2 is
not removing broadband noise, and it is normal to hear
any broadband noise that is present in the original
media.  

When the “On” button is illuminated, SoundSoap 2 is
processing the media according to the current broad-
band tool settings.

When the “Noise Only” button is illuminated, SoundSoap
2 is processing the media according to the current broad-
band noise reduction controls, and is outputting only
the broadband noise that is being reduced. This is a very
useful setting, as it allows you to isolate and hear just the
noise, and is helpful in determining the effectiveness of a
particular noise reduction setting.
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The Broadband mode buttons operate independ-
ently of the Click & Crackle removal slider, and the
Enhance slider.  When broadband noise reduction
is in the Off position, SoundSoap 2 may still be pro-
cessing with its Hum Removal, Click & Crackle, or
Enhance sliders.

Hum Removal Mode Buttons

The Remove Hum buttons in the SoundSoap 2 interface
control whether hum removal is set to remove 50 or 60
Hz hum, or whether hum removal is turned off.  Use
your mouse to select the desired type of hum removal –
the selected Hum Removal type is indicated by an illumi-
nated button.

When the “50 Hz” button is illuminated, SoundSoap 2
will remove 50 Hz hum.  

When the “60 Hz” button is illuminated, SoundSoap 2
will remove 60 Hz hum.  

When the “Off “ button is illuminated, SoundSoap 2’s
Hum Removal feature is inactive.

The Hum Removal buttons operate independently
of other controls.  When Hum Removal is in the Off
position, SoundSoap 2 may still be processing with
its Broadband noise reduction, Click & Crackle,
or Enhance sliders.

Additional Controls in Stand-Alone Edition

The controls in this section are found only in the inter-
face of the stand-alone edition of SoundSoap 2.

Transport Controls

The transport controls are used to start and stop play-
back and to locate the playhead back to the beginning of
the timeline.

Timeline

The timeline provides a linear representation of a media
file that is loaded into SoundSoap 2.  The elements that
make up the timeline include a playhead, and In & Out
locator points.

• The Playhead shows the current location within a file.

• The In & Out points are used to isolate a particular
range of audio.  This can be useful when attempt-
ing to “learn” a noise profile within a short loop of
audio, or when particular noise reduction settings
need to be applied to a particular section of a
media file.
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Counter

The counter provides a numerical representation of the
position of the playhead within the timeline.

Apply Button

The Apply button is used to apply the current settings to
a media file.  The Apply button affects only the audio
material located between the In and Out points.  This
allows different sections of a media file to be cleaned
with different settings.

Concusion

You should now be familiar with the various controls in
the SoundSoap 2 interface.  Please continue to the next
chapter, which gives step-by-step directions on using the
plug-in edition of SoundSoap 2 with a variety of host pro-
grams, as well as using the stand-alone edition.
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Chapter 4:
Using SoundSoap 2

Introduction

This chapter will cover how to use SoundSoap 2 to
reduce noise in digital media files.

SoundSoap 2 is a very flexible program – it can be used
as a plug-in within most Audio Units, DirectX, RTAS, or
VST compatible host programs – as well as stand-alone,
on Mac OS X or Windows XP.

Tips for Noise Reduction

SoundSoap 2 can be used in many ways, but by observ-
ing the following tips, you will get the best results in the
least amount of time.

Recommended Workflow

If you examine SoundSoap 2’s user interface starting
from the left and moving right, this outlines the basic rec-
ommended workflow.   Let’s assume that we’re cleaning
an LP recording which contains clicks, crackles, needle
hiss, and a 60Hz hum.   In this example, we’ll use multi-
ple noise reduction tools, in a suggested order, so as 

to eliminate as much of the unwanted noise as possible,
while preserving as much of the desired audio signal as
possible.

The first step in such an example would be to remove the
random clicks and crackles.   With the media file in your
host program and SoundSoap 2 active, first initiate play-
back, and adjust the Click & Crackle slider until you no
longer hear this type of noise.   Then, find an area in the
recording (such as the very beginning of the record,
before any music starts) in which SoundSoap 2 can
“learn” the profile of the broadband noise.   The host
program’s playhead should be positioned at the begin-
ning of this section, and SoundSoap 2’s Learn Noise but-
ton must be clicked (in the depressed position).   Once
playback is started, SoundSoap 2 will analyze about two
seconds of audio material, the noise profile is deter-
mined, and broadband noise reduction is turned on
automatically.   The next step is to click the Noise Only
button to hear what is being removed.  If any of the
desired audio content is heard, turn the Noise Tuner
Knob slowly to the left (counter-clockwise) until only the
undesired noise is heard.   Next, return SoundSoap 2’s
Broadband mode to “On”.  Turn the Noise Reduction
knob all the way to the left (counter-clockwise).   In this
position, broadband noise reduction is off, and no broad-
band noise is being removed.  Slowly begin to turn the
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Noise Reduction knob to the right (clockwise).  You
should hear the broadband noise begin to fade away,
leaving behind only the desired audio signal (music,
voice, etc).   At this point, click the 60Hz Hum Removal
button to eliminate the low-frequency hum.   If the audio
content you’re working with is just a person’s voice (dia-
logue, a cappella singing, etc), you would also click the
Preserve Voice button to automatically help filter any
noise that lies outside of the frequency range of the
human voice.   Much of the unwanted noise should now
be eliminated (or greatly reduced).

In some instances, when working with degraded media
sources, you may wish to use the Enhance slider to help
restore tonality that was present in the original record-
ing.  The Enhance slider is recommended as a final pro-
cessing step, when all other settings have been made.

Following this basic “left to right” order of operations will
allow you to achieve quick and easy noise reduction results.
In cases where you only have one type of noise (ie, clicks
and crackles, broadband noise, hum), simply use the tools
that are needed, and leave the others in the “Off ” position.

Sampling Broadband Noise

Often, the noisy media that you encounter will have areas
where there is just the undesired noise present, and none
of the audio signal that should be kept.  A simple but very
common example would be video footage of an interview
– this situation would contain spoken word, interspersed
with silence (or what should be silence, except for the
undesired noise).  In cases such as this, the “silent” areas
will contain the same noise that gets in the way of us hear-
ing the voice of the person being interviewed.  These silent
sections of the file allow us to sample just the noise itself,
essentially telling SoundSoap 2 what to remove from the
entire file.  The end result is that the undesired noise is
reduced equally in all parts of the file, making the desired
audio signal much cleaner.

In other cases, there may not be an area present in your
media file that contains just the undesired noise.  In media
files that contain the desired audio and undesired noise
throughout the entire length of the file, it is often best to
first experiment and learn the noise in different parts of the
file to get the best noise reduction results.  This can be
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Media file (shown in BIAS Peak) with good target area selected for noise sampling – the selected portion of the waveform in this area con-

tains just the undesired broadband background noise.



done by clicking the Learn Noise button in various parts of
the file as it plays, or by positioning the playhead cursor in
your host program in a specific location, clicking the Learn
Noise button, and starting playback.  When you find the
settings that work best, you can then apply, or render
them, to the entire file.  

Real-time effects plug-ins, such as SoundSoap 2, are
designed to process audio as parameters are adjust-
ed.  Once the ideal settings are made, the plug-in
must be applied, or rendered to the media file, in
order to make the changes permanent.  In audio
editing software, the term “Bounce” is commonly
used to describe the process of applying plug-in set-
tings to a file.

Another approach to “learning” noise in a part of a media file
which contains both the unwanted background noise and
the desired audio is to locate a section within the file that has
the lowest signal to noise ratio.  For example, in a digital
recording of an audio cassette, there will likely be a low level
hiss throughout the file.  If this file does not have a section

with the cassette hiss by itself, then the next best option for
“learning” the noise is to use SoundSoap 2’s Learn Noise fea-
ture in a part of the file where the desired audio content is
at its lowest level, compared to the level of unwanted noise.

If in the noise sampling process it seems that different
settings would work best for different parts of the file,
consult the next section.

In some cases, you may have an isolated section of
broadband noise which is shorter than the two seconds
that SoundSoap 2 needs to “learn” the profile of frequen-
cies responsible for this noise.   In these cases, a useful
technique is to “loop” the very short section several
times, until SoundSoap 2 can analyze the audio content
for two seconds and determine the noise profile. 

For example, let’s say we’re working with a cassette
recording, and the only sections where the noise exists
by itself is in the pauses between songs.   Creating a loop
in one of these sections, and then clicking the Learn
Noise button and initiating playback, will loop this sec-
tion of the file over and over.   After playing the loop
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Repeating a short loop can give SoundSoap 2 enough audio material to analyze the frequencies causing the unwanted noise.  In this cas-
sette recording (shown in BIAS Peak) we’ve created a short loop between two songs – the loop contains just the unwanted broadband noise
(tape hiss).  The cursor information (circled) display shows the loop’s length to be 1.09 seconds – by engaging Learn Noise mode and play-
ing the loop at least twice, SoundSoap 2 will have enough audio material (approx. 2 seconds) to accurately create a noise profile.



twice, SoundSoap 2 will have had enough audio material
(approximately two seconds) to analyze and accurately
create a noise profile.   

At this point, use Noise Only mode to hear if the noise
profile created will accurately remove just the undesired
noise, and none of the desired audio content.   The loop
start and end points may need to be fine-tuned and the
noise profile “re-learned”.

Most host programs will allow certain portions of
a media file to be looped.   The stand-alone edition

of SoundSoap 2 is also capable of this – simply set

the In point and Out point to the desired locations,
and then activate Loop mode.  When SoundSoap 2
has “learned” the noise don’t forget to de-activate
Loop mode.  Also, if you need to clean the entire
file, don’t forget to reset the In and Out points – the
Apply button only affects the audio material con-
tained within the In and Out points.

To Learn Noise in Loop Mode (Stand-Alone Edition)

1. Locate a portion of the file which contains a very
short portion of just the unwanted background
noise.

2. Drag the In point marker to the beginning of this
section.

3. Drag the Out Point marker to the end of the section.

4. From the Transport menu, choose Loop (or press
the L key on your keyboard).

5. Click the Learn Noise button.

6. Click the Play button – once a noise profile is
learned, (and noise reduction turns on automati-
cally) stop playback.

7. Move the In point marker back to its original posi-
tion at the beginning of the timeline.

8. Move the Out point marker back to its original
position at the end of the timeline.

To reselect the entire timeline, you may also use
the keyboard shortcuts �-A on Mac, and Ctrl-A on
Windows.

9. Click the Apply button when you are happy with
your settings – since the In & Out point buttons
have been put back in their original positions, the
entire timeline will be processed.
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10. From the File menu, choose Save As. 

Constant Noise v.  Changing Noise (Broadband)

Noisy media can be categorized into two basic groups –
that which has a constant noise level and type, and that
which has varying levels and types of noise throughout.
Each category of media can be cleaned best by using a
slightly different approach to noise reduction.

Constant Noise

Media files with a constant noise level and type of noise
are generally the easiest to clean.  This noise type is typ-
ically found in recordings of audio or analog video cas-
settes, or in cases where there is a constant hum present
due to using equipment that is plugged into poorly
grounded electrical circuits.  There may sometimes be

unwanted noise in a recording environment, such as a
heating/ventilation system, industrial equipment, etc.

Media that falls into this category can usually be cleaned
by sampling the noise and creating just a single noise
profile.  In other words, in media with a constant noise
level and type of noise, you should be able to open a file,
click the “Learn Noise” button to automatically profile
the noise, and set the Noise Tuner and Noise Reduction
knobs, perhaps fine-tune those settings, and then
“bounce” or render the noise reduction settings to the
file.

Changing Noise

Noise in a media file may vary over time – for example, a
video clip may contain air conditioning noise that varies in
intensity throughout the clip, due to the camera being
moved around the room while taping a subject.  In cases
like this, it is best to apply noise reduction with different set-
tings for the different levels of noise that occur in various
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Audio document (shown in BIAS Peak) with three distinct noise types – note use of region markers for reference



parts of the clip.  To reduce noise by varying degrees in dif-
ferent sections of a clip, simply select specific “target” areas,
apply noise reduction with certain settings, and then move
on to each area of the clip, targeting the specific noise that
occurs in each.  This will generally yield the best results, as
one noise reduction setting alone may not be suitable for
the different levels and/or kinds of noise that occur over the
course of the entire file.

If your host program allows the use of reference markers
and/or regions (such as those found in BIAS Peak), you may
want to “mark up” a file into sections that contain different
levels of noise or different noise types.  This is a good strat-
egy for isolating and processing areas of the file with a cer-
tain level and kind of noise, and then moving on to another
section and processing it with different noise reduction set-
tings more suitable for its level and noise type.

SoundSoap 2 (the stand-alone application) offers a
timeline for navigation.  While this allows for deter-
mining where the isolated noise should be learned,
a vaveform editor (such as Peak) provides addition-
al visual feedback that makes determining the
appropriate area where noise should be learned
much easier.

If using a host that allows automation of plug-in parame-
ters, SoundSoap 2’s parameters may be automated as with
any other plug-in.  Dynamic parameter changes can be very
useful when dealing with noise that varies over time.

Using SoundSoap 2 with other Software

The following section will describe the noise reduction
process step by step within the following host programs
(a host program being the main editing program that
SoundSoap 2 “plugs into”, to expand its processing capa-
bilities), as well as using the stand-alone edition of
SoundSoap 2 with audio/video editing software that
does not directly support Audio Units, DirectX,
RTAS/AudioSuite, or VST format audio plug-ins:

• BIAS Peak 4 (Audio Units/VST)

• Apple iMovie 4 (Stand-Alone Edition)

• Sonic Foundry Sound Forge 7 (DirectX)

• Steinberg Cubase SX 2 ( VST)

• Apple Logic Pro (Audio Units)

• Digidesign Pro Tools (RTAS)

• Apple GarageBand (Audio Units)

• Adobe Premiere Pro ( VST)

It is normal for operation to vary slightly depending on
the plug-in implementation in each host program.  If the
host you plan to use SoundSoap 2 with is not listed here,
it is recommended that you consult the documentation
provided with your host program for details on how to
use plug-in effects.  In terms of instantiating and applying
effects, SoundSoap 2 will operate in much the same way
as other plug-ins that conform to the Audio Units,
DirectX, RTAS/AudioSuite, and VST standards.

Using SoundSoap 2 with BIAS Peak

In this example, we’ll be using Peak 4.1 as a host applica-
tion, to restore an LP recording which contains various
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noise types.   If the file you are restoring does not con-
tain all the same types of noise, simply omit the steps for
noise types not present in your recording.   

To use SoundSoap 2 with BIAS Peak, you will need
to be running either Peak Express, Peak LE, Peak
DV, or Peak (version 3.2 or later) and have
already installed SoundSoap 2 on your Macintosh
system.   Peak 3.2 is available as a free update to

users of Peak 3.0x – 3.1x.   This update may be

downloaded from the BIAS website, at:  

http://www.bias-inc.com/support/updates/

The first step in reducing noise in digital media is to open
the file in Peak, then open the SoundSoap 2 plug-in.  The
following steps will guide you through your first attempts
at noise reduction.

1.  Launch Peak.

2.  Open noisy media file.

3.  Choose “Insert 1>Audio Units>BIAS>
SoundSoap” from the Plug-Ins menu.  

In this example, we’re using the Audio Units for-

mat plug-in of SoundSoap 2.   Peak supports both
VST and Audio Units formats plug-ins.  To use the
VST format plug-in, simply choose “Insert
1>VST>SoundSoap 2” from Peak’s Plug-Ins
menu, rather than choosing the Audio Units for-
mat version.   The following steps are exactly the
same in either version of the plug-in.

4.  When the SoundSoap 2 interface appears, turn
Broadband noise reduction to Off (it is on by default).

5. Play the LP recording from the beginning, and slowly
raise the Click & Crackle slider until you no longer hear
this type of noise.  When you find the ideal setting, try
playing various parts of the recording, ensuring that the
setting you have chosen will repair clicks/crackles of
varying degrees throughout the entire recording.

If the clicks/crackles vary greatly from song to
song, you may want to work on each song sepa-
rately, processing each with a more precise setting.  

Now, we’ll remove the broadband noise from this record-
ing (needle hiss), as well as the 60Hz hum and very low
frequency turntable motor rumble...

6.  Click the 60Hz Hum Removal button.
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7.  Click the Remove Rumble button.

The Hum Removal, Remove Rumble, and Preserve

Voice features operate independently of the other
noise reduction tools (Click & Crackle Slider, Noise
Tuner & Noise Reduction knobs, and Learn Noise
button), and can be toggled on or off either before
or after learning a noise profile, and will not
affect the accuracy of the learned noise profile.

8.  Return to the beginning of the recording (before
the music or other program material begins), and
click the Learn Noise button.

9. Start playback by pressing the space bar, or by click-
ing the Play button in Peak’s transport window.
After analyzing the audio content for approximate-
ly two seconds, SoundSoap 2 will automatically
turn on broadband noise reduction.

10.  Listen to the results.  To apply/render the current
noise reduction settings, choose “Bounce...” from
Peak’s Plug-Ins menu.  

Congratulations! You’ve just learned the basics of using
SoundSoap 2.  To learn more advanced techniques, con-

tinue along with the next few steps, and apply
SoundSoap 2 when you have completed all the advanced
steps.

11.  Start playback of the audio material, and click the
Noise Only button – in Noise Only mode, you
should hear only the unwanted broadband noise.  

12. If you hear any of the desired audio material, turn
the Noise Tuner knob to the left (counter-clock-
wise), until you hear only the unwanted noise.

13.  Click the On button to return to the regular listen-
ing mode.

14.  Turn the Noise Reduction knob all the way to the
left (counter-clockwise) – in this position, no
broadband noise reduction is being applied.
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15.  Now, slowly turn the Noise Reduction knob to the
right (clockwise), until you reach the optimal bal-
ance between broadband noise reduction and
introducing any unwanted artifacts.

16.  Slowly raise the Enhance slider to help add tonali-
ty and boost frequencies that are commonly lost in
degraded media sources (if you are working with a
recording made from a degraded media source).

17.  When you are satisfied with the results, choose
“Bounce...” from Peak’s Plug-Ins menu.

Be sure to disable SoundSoap 2 after “bouncing”.

If you leave SoundSoap 2 active, you will hear the
processed file being played through SoundSoap 2
in realtime, giving the effect of twice the amount of
noise reduction.  For your convenience, a dialog
box is presented after bouncing in Peak, with
options to turn plug-ins off, or to leave them active
if you need to process additional files.

Using the Stand-Alone Edition of SoundSoap 2 with

Apple iMovie

iMovie users can also use SoundSoap 2 to remove
unwanted noise that may be picked up by the built-in mic
in a DV camera.   While iMovie does not directly support
audio plug-ins or an external audio editor, a handy fea-
ture called “Extract Audio” makes the process of cleaning
clips very easy.  Once audio is extracted, it can be opened
in Peak and cleaned with the SoundSoap plug-in, or can
be opened directly in the stand-alone edition of
SoundSoap.

The steps below outline the fastest and easiest method of
cleaning up noisy media from an iMovie project, using
the stand-alone edition of SoundSoap.

1.  Open an iMovie project.

2.  Click on a clip in the iMovie timeline (a clip that
contains broadband noise) to select it.

DV clip highlighted in blue indicates that it is selected
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3.  From the “Advanced” menu, choose “Extract
Audio” – the extracted audio is placed on an audio
track, beneath the video track in the timeline.

4.  Save your iMovie project.

5.  Quit iMovie.

6.  Open the “Media” folder for the iMovie project you
are working on, and notice that among the various
clips, there is now also an audio clip called “Voice
01”.   ( Voice 01 is the default name given to the first
extracted audio clip, Voice 02 for the second, and
so on).

7.  Launch the stand-alone edition of SoundSoap 2.

8.  From the File menu, choose Open Media File, and
navigate to the “Media” folder for your iMovie proj-
ect – open the audio clip called “Voice 01” (or drag
and drop the file over the SoundSoap 2 interface).

9.  When the SoundSoap 2 interface appears, turn
Broadband noise reduction to Off (it is on by default).

10. Click the Play button, and evaluate which noise
reduction tools should be used.

In this example, we’ll assume that only broadband
background noise is present, and will use only the
broadband noise reduction tools.  Broadband
noise is the most common type of noise found in
digital video footage.

11.  Locate a portion of the media file which contains
just the unwanted noise by itself, and click the
Learn Noise button.

If the media file you are working with does not contain

any areas with approximately two seconds of the noise by
itself, you may want to try creating a “loop” of a shorter
section.  To create a loop in a particular section of your
media file, simply drag the In point marker to the begin-
ning of this section, and the Out point marker to the end
of this section.  Then, choose “Loop” from the Transport
menu.  Click the Learn Noise button, and initiate play-

back – SoundSoap 2 will use the looped section of audio

to create a noise profile.  Be sure to move the In and Out
point markers back to their original positions after you’ve
learned the noise profile.  For more information, please
see the section on “Tips for Noise Reduction” on page 39.

Notice that the extracted audio is placed onto one of iMovie’s audio
tracks 
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12. Start playback by pressing the space bar, or by clicking
the Play button.  After analyzing the audio content for
approximately two seconds, SoundSoap 2 will auto-
matically turn on broadband noise reduction.

13.  Listen to the results.  To apply/render the current
noise reduction settings, click the Apply button.

14.  To save the cleaned file, choose Save As from the
file menu.

15. When prompted for a location to save the file,
select the Media folder for your iMovie project –
AND save the cleaned clip with the exact same
name as the original audio clip.  

16. If the clip was originally called “Voice 01”, save the
cleaned file as “Voice 01”.  When prompted about
replacing a file with the same name, click the
Replace button. 

The stand-alone edition of SoundSoap 2 always

creates a new file, and never changes the original
media.  However, by choosing to replace the origi-
nal extracted audio file with the cleaned audio
file, and using the exact same file name – the next
time iMovie is launched, it will load in the cleaned
audio clip, in sync with the video.  This technique
of overwriting the extracted audio clip will only
alter the extracted audio, not the audio contained
in the original DV clip.  If at any point you wish to
return the DV clip to its original state, simply
delete the extracted audio from the iMovie audio
track, and un-mute the audio in the video track.

Another method that can be used is saving the cleaned
file under a different file name, and then importing it into
the iMovie project.  Using this technique requires replac-
ing the original audio clip (the audio that was originally
extracted) with the cleaned version.

Congratulations! You’ve just learned the basics of using
SoundSoap 2.  Now, we’ll show some advanced tech-
niques to fine tune your noise reduction results.

17.  Start playback of the audio material, and click the
Noise Only button – in Noise Only mode, you
should hear only the unwanted broadband noise.  

18. If you hear any of the desired audio material, turn
the Noise Tuner knob to the left (counter-clock-
wise), until you hear only the unwanted noise.
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19.  Click the On button to return to the regular listen-
ing mode.

20.  Turn the Noise Reduction knob all the way to the
left (counter-clockwise) – in this position, no
broadband noise reduction is being applied.

21.  Now, slowly turn the Noise Reduction knob to the
right (clockwise), until you reach the optimal bal-
ance between broadband noise reduction and
introducing any unwanted artifacts.

22.  Slowly raise the Enhance slider to help add tonali-
ty and boost frequencies that are commonly lost in
degraded media sources (if you are working with a
recording made from a degraded media source).

23.  When you are satisfied with the results, choose
“Save As” from the File menu.

Using SoundSoap 2 with Sony Sound Forge

To use SoundSoap 2 with Sound Forge, you will need to
have already installed SoundSoap 2 on your PC system.  

In this example, we’ll be using Sound Forge as a host pro-
gram, and we’ll be restoring an LP recording which con-
tains multiple types of noise.   If the file you are restoring
does not contain all the same types of noise, simply omit
the steps for noise types not present in your recording.   

The first step in reducing noise is to open the media in
Sound Forge, and then open SoundSoap 2.  The follow-
ing steps will guide you through your first attempts at
noise reduction.

1.  Launch Sound Forge.
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2.  Open media file.

3.  From the View menu, choose Plug-In Chainer.

4. Click the Add Plug-Ins to Chain button.

5. Select BIAS SoundSoap and click the OK button.

6. When the SoundSoap 2 interface appears within
the Plug-In Chainer, turn Broadband noise reduc-
tion to Off (it is on by default).

7. Play the LP recording from the beginning, and
slowly raise the Click & Crackle slider until you no
longer hear this type of noise.  When you find the
ideal setting, try playing various parts of the record-
ing, to make sure that the setting you have chosen
will repair clicks/crackles of varying degrees
throughout the entire recording.

If the clicks/crackles vary greatly from song to
song, you may want to work on each song sepa-
rately, processing each with a more precise setting.  

Now, we’ll remove the broadband noise from this record-
ing (needle hiss), as well as the 60Hz hum and very low
frequency turntable motor rumble...

8.  Click the 60Hz Hum Removal button.

9.  Click the Remove Rumble button.
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The Hum Removal, Remove Rumble, and Preserve

Voice features operate independently of the other
noise reduction tools (Click & Crackle Slider, Noise
Tuner & Noise Reduction knobs, and Learn Noise
button), and can be toggled on or off either before
or after learning a noise profile, and will not
affect the accuracy of the learned noise profile.

10.  Return to the beginning of the recording (before
the music or other program material begins), and
click the Learn Noise button.

11. Start playback – after analyzing the audio content
for approximately two seconds, SoundSoap 2 will
automatically turn on broadband noise reduction.

12.  Listen to the results.  To apply/render the current
noise reduction settings, click the Process
Selection button in the Plug-In Chainer window.  

Congratulations! You’ve just learned the basics of using
SoundSoap 2.  To learn more advanced techniques, con-
tinue along with the next few steps, and apply
SoundSoap 2 when you have completed all the advanced
steps.

13.  Start playback of the audio material, and click the
Noise Only button – in Noise Only mode, you

should hear only the unwanted broadband noise.  

14. If you hear any of the desired audio material, turn
the Noise Tuner knob to the left (counter-clock-
wise), until you hear only the unwanted noise.

15.  Click the On button to return to the regular listening
mode.

16.  Turn the Noise Reduction knob all the way to the
left (counter-clockwise) – in this position, no
broadband noise reduction is being applied.

17.  Now, slowly turn the Noise Reduction knob to the
right (clockwise), until you reach the optimal bal-
ance between broadband noise reduction and
introducing any unwanted artifacts.
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18.  Slowly raise the Enhance slider to help add tonali-
ty and boost frequencies that are commonly lost in
degraded media sources (if you are working with a
recording made from a degraded media source).

19.  When you are satisfied with the results, click the
Process Selection button in the Plug-In Chainer
window, and be sure to save the file.

Using SoundSoap 2 with Steinberg Cubase SX

To use SoundSoap 2 with Steinberg Cubase SX, you will
need to have already installed SoundSoap 2 on your PC
or Macintosh system.

The first step in reducing noise is to open the media in

Cubase SX, and then open SoundSoap 2.  The following
steps will guide you through your first attempts at noise
reduction.

In this example, we’ll be using Cubase SX as a host appli-
cation, and we’ll be restoring an LP recording which con-
tains multiple types of noise.   If the file you are restoring
does not contain all the same types of noise, simply omit
the steps for noise types not present in your recording.   

1.  Launch Cubase SX, and open a project/create a
new project.

2.  Import noisy media file into the project.

3.  In the track control area to the left of the track,

click the Edit button (“e”).

4. In the VST Audio Channel Settings window, add
SoundSoap 2 as the first effect insert.

5.  When the SoundSoap 2 interface appears, turn
Broadband noise reduction to Off (it is on by default).
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6. Play the LP recording from the beginning, and slowly
raise the Click & Crackle slider until you no longer hear
this type of noise.  When you find the ideal setting, try
playing various parts of the recording, to make sure
that the setting you have chosen will repair
clicks/crackles of varying degrees throughout the
entire recording.

If the clicks/crackles vary greatly from song to

song, you may want to work on each song sepa-
rately, processing each with a more precise setting.  

Now, we’ll remove the broadband noise from this record-
ing (needle hiss), as well as the 60Hz hum and very low
frequency turntable motor rumble...

7.  Click the 60Hz Hum Removal button.

8.  Click the Remove Rumble button.

The Hum Removal, Remove Rumble, and Preserve

Voice features operate independently of the other
noise reduction tools (Click & Crackle Slider, Noise
Tuner & Noise Reduction knobs, and Learn Noise
button), and can be toggled on or off either before
or after learning a noise profile, and will not
affect the accuracy of the learned noise profile.

9.  Return to the beginning of the recording (before
the music or other program material begins), and
click the Learn Noise button.

10. Start playback– after analyzing the audio content
for approximately two seconds, SoundSoap 2 will
automatically turn on broadband noise reduction.

11.  Listen to the results – to process the file with the
current settings, select the desired range to
process with the Left/Right selection markers, and
from the File menu choose Export>Selected
Tracks.  



Congratulations! You’ve just learned the basics of using
SoundSoap 2.  To learn more advanced techniques, con-
tinue along with the next few steps, and apply
SoundSoap 2 when you have completed all the advanced
steps.

If you need to use the cleaned file within this

Cubase project, import the cleaned file – other-
wise, the cleaned file is ready to use in the directo-

ry where you exported.

12.  Start playback of the audio material, and click the
Noise Only button – in Noise Only mode, you
should hear only the unwanted broadband noise.  

13. If you hear any of the desired audio material, turn
the Noise Tuner knob to the left (counter-clock-
wise), until you hear only the unwanted noise.

14.  Click the On button to return to the regular listen-
ing mode.

15.  Turn the Noise Reduction knob all the way to the
left (counter-clockwise) – in this position, no
broadband noise reduction is being applied.

16.  Now, slowly turn the Noise Reduction knob to the
right (clockwise), until you reach the optimal bal-
ance between broadband noise reduction and
introducing any unwanted artifacts.

17.  Slowly raise the Enhance slider to help add tonali-
ty and boost frequencies that are commonly lost in
degraded media sources (if you are working with a
recording made from a degraded media source).
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18.  When you are satisfied with the results, select the
desired range to process with the Left/Right selec-
tion markers, and from the File menu choose
Export>Selected Tracks.

If you need to use the cleaned file within this
Cubase project, import the cleaned file – other-
wise, the cleaned file is ready to use in the directo-
ry where you exported.

Using SoundSoap 2 with Logic Pro

To use SoundSoap 2 with Logic Pro, you will need to have
already installed SoundSoap 2 on your Macintosh system.

In this example, we’ll be using Logic Pro as a host appli-
cation, and we’ll be restoring an LP recording which con-
tains multiple types of noise.   If the file you are restoring
does not contain all the same types of noise, simply omit
the steps for noise types not present in your recording.   

1.  Launch Logic Pro.

2.  Create a new session, and drag a noisy media file
from the Finder into the Arrange Window.

3.  In the Mixer Window, assign SoundSoap 2 as an
insert in the channel that corresponds to the track
where the noisy audio file was placed.

4.  When the SoundSoap 2 interface appears, turn
Broadband noise reduction to Off (it is on by default).

5. Play the LP recording from the beginning, and
slowly raise the Click & Crackle slider until you no
longer hear this type of noise.  When you find the
ideal setting, try playing various parts of the record-
ing, to make sure that the setting you have chosen
will repair clicks/crackles of varying degrees
throughout the entire recording.
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If the clicks/crackles vary greatly from song to

song, you may want to work on each song sepa-
rately, processing each with a more precise setting.  

Now, we’ll remove the broadband noise from this record-
ing (needle hiss), as well as the 60Hz hum and very low
frequency turntable motor rumble...

6.  Click the 60Hz Hum Removal button.

7.  Click the Remove Rumble button.

The Hum Removal, Remove Rumble, and Preserve

Voice features operate independently of the other
noise reduction tools (Click & Crackle Slider, Noise
Tuner & Noise Reduction knobs, and Learn Noise
button), and can be toggled on or off either before
or after learning a noise profile, and will not
affect the learned noise profile.

8.  Return to the beginning of the recording (before
the music or other program material begins), and
click the Learn Noise button.

9. Start playback by pressing the space bar, or by click-
ing the Play button in Logic’s transport window –
after analyzing the audio content for approximate-
ly two seconds, SoundSoap 2 will automatically
turn on broadband noise reduction.

10.  Listen to the results – to apply/render the current
noise reduction settings, click the Bounce (Bnce)
button in the master outputs section of the Logic
mixer window.

Congratulations! You’ve just learned the basics of using
SoundSoap 2.  To learn more advanced techniques, con-
tinue along with the next few steps, and apply
SoundSoap 2 when you have completed all the advanced
steps.

11.  Start playback of the audio material, and click the
Noise Only button – in Noise Only mode, you
should hear only the unwanted broadband noise.  

12. If you hear any of the desired audio material, turn
the Noise Tuner knob to the left (counter-clock-
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wise), until you hear only the unwanted noise.

13.  Click the On button to return to the regular listen-
ing mode.

14.  Turn the Noise Reduction knob all the way to the
left (counter-clockwise) – in this position, no
broadband noise reduction is being applied.

15.  Now, slowly turn the Noise Reduction knob to the
right (clockwise), until you reach the optimal bal-
ance between broadband noise reduction and
introducing any unwanted artifacts.

16.  Slowly raise the Enhance slider to help add tonali-
ty and boost frequencies that are commonly lost in

degraded media sources (if you are working with a
recording made from a degraded media source).

17.  When you are satisfied with the results, click the
Bounce (Bnce) button in the master outputs sec-
tion of the Logic mixer window, and be sure to save
the file.
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Using SoundSoap 2 with Pro Tools

To use SoundSoap 2 with Pro Tools, you will need to have
already installed SoundSoap 2 on your PC or Macintosh
system.

In this example, we’ll be using Pro Tools as a host appli-
cation, and we’ll be restoring an LP recording which con-
tains multiple types of noise.   If the file you are restoring
does not contain all the same types of noise, simply omit
the steps for noise types not present in your recording.   

1.  Launch Pro Tools.

2.  Create a new session and import a noisy media file
to a track in the Pro Tools session.

3.  In the Mixer window, add SoundSoap 2 as an effect
insert on the channel that corresponds to the track
where the noisy audio file was added.

4.  When the SoundSoap 2 interface appears – turn
Broadband noise reduction to Off (it is on by default).

5. Play the LP recording from the beginning, and

slowly raise the Click & Crackle slider until you no
longer hear this type of noise.  When you find the
ideal setting, try playing various parts of the record-
ing, to make sure that the setting you have chosen
will repair clicks/crackles of varying degrees
throughout the entire recording.

If the clicks/crackles vary greatly from song to

song, you may want to work on each song sepa-
rately, processing each with a more precise setting.  

Now, we’ll remove the broadband noise from this record-
ing (needle hiss), as well as the 60Hz hum and very low
frequency turntable motor rumble...

6.  Click the 60Hz Hum Removal button.

7.  Click the Remove Rumble button.
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The Hum Removal, Remove Rumble, and Preserve

Voice features operate independently of the other
noise reduction tools (Click & Crackle Slider, Noise
Tuner & Noise Reduction knobs, and Learn Noise
button), and can be toggled on or off either before
or after learning a noise profile, and will not
affect the accuracy of the learned noise profile.

8.  Return to the beginning of the recording (before
the music or other program material begins), and
click the Learn Noise button.

9. Start playback  – after analyzing the audio content
for approximately two seconds, SoundSoap 2 will
automatically turn on broadband noise reduction.

10.  Listen to the results – to apply/render the current
noise reduction settings, choose Bounce to Disk
from the File menu.

Congratulations! You’ve just learned the basics of using
SoundSoap 2.  To learn more advanced techniques, con-

tinue along with the next few steps, and apply SoundSoap
2 when you have completed the additional steps.

11.  Start playback of the audio material, and click the
Noise Only button – in Noise Only mode, you
should hear only the unwanted broadband noise.  

12. If you hear any of the desired audio material, turn
the Noise Tuner knob to the left (counter-clock-
wise), until you hear only the unwanted noise.

13.  Click the On button to return to the regular listen-
ing mode.

14.  Turn the Noise Reduction knob all the way to the
left (counter-clockwise) – in this position, no
broadband noise reduction is being applied.

15.  Now, slowly turn the Noise Reduction knob to the

SoundSoap 2 User’s Guide58



right (clockwise), until you reach the optimal bal-
ance between broadband noise reduction and
introducing any unwanted artifacts.

16.  Slowly raise the Enhance slider to help add tonali-
ty and boost frequencies that are commonly lost in
degraded media sources (if you are working with a
recording made from a degraded media source).

17.  When you are satisfied with the results, choose
Bounce to Disk from the File menu to apply/render
the current noise reduction settings.

Using SoundSoap 2 with GarageBand

To use SoundSoap 2 with GarageBand, you will need to
have already installed SoundSoap 2 on your Macintosh
system.

In this example, we’ll be using GarageBand as a host
application, and we’ll be restoring an LP recording which
contains multiple types of noise.  If the file you are
restoring does not contain all the same types of noise,
simply omit the steps for noise types not present in your
recording.   

1.  Launch GarageBand, and create a new song proj-
ect.

2.  Delete the default virtual instrument that is auto-
matically loaded into a new song project – select
the track, and from the Track menu, choose Delete
Track.

3.  Create a new Basic Track – from the Track menu,
choose New Basic Track.
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4. Drag a noisy media file from the Finder into the
new track.

The previous step assumes that we’re working with
a pre-recorded media file.  As an alternative, you
may also record directly into GarageBand, and
then apply noise reduction.  For more informa-
tion on recording directly into GarageBand,
please consult the GarageBand Help file.

5. Double-click the track header area – the Track Info
window appears.

6. Click the Details... disclosure triangle to show addi-
tional information about effects.

7. In the first (upper) Effects pop-up menu, choose
SoundSoap.

8. Click the Open Editor button to access the
SoundSoap 2 interface.  

Be sure that all other effects are inactive while
adjusting noise reduction controls!  This can be
done by unchecking the checkbox to the left of the
Effect’s name.  If other effects are active at the
same time as SoundSoap 2, it will be difficult to
focus on removing the unwanted noise!  Other
effects may be used at the same time as SoundSoap
2, but it is recommended to first finalize noise
reduction settings, and to add other desired effects

later.

9. When the SoundSoap 2 interface appears – turn
Broadband noise reduction to Off (it is on by default).

10. Play the LP recording from the beginning, and
slowly raise the Click & Crackle slider until you no
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longer hear this type of noise.  When you find the
ideal setting, try playing various parts of the record-
ing, to make sure that the setting you have chosen
will repair clicks/crackles of varying degrees
throughout the entire recording.

If the clicks/crackles vary greatly from song to

song, you may want to work on each song sepa-
rately, processing each with a more precise setting.  

Now, we’ll remove the broadband noise from this record-
ing (needle hiss), as well as the 60Hz hum and very low
frequency turntable motor rumble...

11.  Click the 60Hz Hum Removal button.

12.  Click the Remove Rumble button.

The Hum Removal, Remove Rumble, and Preserve

Voice features operate independently of the other
noise reduction tools (Click & Crackle Slider, Noise
Tuner & Noise Reduction knobs, and Learn Noise
button), and can be toggled on or off either before
or after learning a noise profile, and will not
affect the accuracy of the learned noise profile.

13.  Return to the beginning of the recording (before
the music or other program material begins), and
click the Learn Noise button.

14. Start playback  – after analyzing the audio content
for approximately two seconds, SoundSoap 2 will
automatically turn on broadband noise reduction.

15.  Listen to the results – to apply/render the current
noise reduction settings, choose Export to iTunes
from the File menu.

Congratulations! You’ve just learned the basics of using
SoundSoap 2.  To learn more advanced techniques, con-
tinue along with the next few steps, and apply SoundSoap
2 once you have completed them.
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16.  Start playback of the audio material, and click the
Noise Only button – in Noise Only mode, you
should hear only the unwanted broadband noise.  

17. If you hear any of the desired audio material, turn
the Noise Tuner knob to the left (counter-clock-
wise), until you hear only the unwanted noise.

18.  Click the On button to return to the regular listen-
ing mode.

19.  Turn the Noise Reduction knob all the way to the
left (counter-clockwise) – in this position, no
broadband noise reduction is being applied.

20.  Now, slowly turn the Noise Reduction knob to the
right (clockwise), until you reach the optimal bal-
ance between broadband noise reduction and

introducing any unwanted artifacts.

21.  Slowly raise the Enhance slider to help add tonali-
ty and boost frequencies that are commonly lost in
degraded media sources (if you are working with a
recording made from a degraded media source).

22.  When you are satisfied with the results, choose
Export to iTunes from the File menu to apply/ren-
der the current noise reduction settings.

The cleaned LP recording is now available as an AIFF file
in your iTunes library, which can easily be burned to CD,
transfered to an iPod, or imported into many other appli-
cations.
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Using SoundSoap 2 with Adobe Premiere Pro

To use SoundSoap 2 with Premiere Pro, you will need to have
already installed SoundSoap 2 on your Windows system.

In this example, we’ll be using Premiere Pro as a host
program, and we’ll be cleaning up a noisy video clip.   

The steps below outline using SoundSoap 2 as a real-time
VST format plug-in, within the Premiere audio mixer.
SoundSoap 2 may also be used as an “offline” effect, by
dragging the SoundSoap 2 effect from the Project window
onto a noisy media clip placed in the timeline.  For more
information on using SoundSoap 2 as an offline effect,
please consult the Premiere Pro user’s guide – SoundSoap
2 is applied in the same way as other offiline effects.

1.  Launch Premiere Pro and create a new
project/open an existing project.

2. Import a noisy media file.

3. Drag noisy media file into the Timeline window.

4. From the Window menu, choose Audio Mixer.

5. In the Audio Mixer, add SoundSoap 2 as an effect
insert (corresponding to the audio track contain-
ing the audio portion of the noisy media file).

6. Once SoundSoap 2 is added as an insert, right-click
on its name in the active insert, and choose Edit...
from the pop-up menu.

7. When the SoundSoap 2 interface appears, set the
Broadband mode to Off, and play back the project,
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listening to the noise content, and evaluating
which noise reduction tools should be used.

In this example, we’ll assume that only broadband
background noise is present, and will use only the
broadband noise reduction tools.  Broadband
noise is the most common type of noise found in

digital video footage.

8. Locate a portion of the file which contains just the
unwanted broadband noise and place the
Timeline’s playhead at the beginning of this sec-
tion.

If the media file you are working with does not
contain any areas with approximately two sec-
onds of the noise by itself, you may want to try cre-
ating a “loop” of a shorter section.  To create a loop
in a particular section of your media file, simply
drag the In point marker to the beginning of this
section, and the Out point marker to the end of this
section.  Then, choose “Loop” from the Transport
menu.  Click the Learn Noise button, and initiate

playback – SoundSoap 2 will use the looped sec-

tion of audio to create a noise profile.  Be sure to
move the In and Out point markers back to their
original positions after you’ve learned the noise
profile.  For more information, please see the sec-
tion on “Tips for Noise Reduction” on page 39.

9. Click SoundSoap 2’s Learn Noise button and start
playback.  After analyzing the audio content for
approximately two seconds, SoundSoap 2 will auto-
matically turn on broadband noise reduction.

10. Listen to the results – if you are happy with the
results, simply close the SoundSoap 2 interface and
leave the insert active in the Audio Mixer window.
Noise reduction settings will be applied when you
export the project from Premiere Pro.

Congratulations! You’ve just learned the basics of using
SoundSoap 2.  To learn more advanced techniques, con-
tinue along with the next few steps.

11. Start playback of the audio material, and click the
Noise Only button – in Noise Only mode, you
should hear only the unwanted broadband noise.  

12. If you hear any of the desired audio material, turn
the Noise Tuner knob to the left (counter-clock-
wise), until you hear only the unwanted noise.
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13.  Click the On button to return to the regular listen-
ing mode.

14.  Turn the Noise Reduction knob all the way to the
left (counter-clockwise) – in this position, no
broadband noise reduction is being applied.

15.  Now, slowly turn the Noise Reduction knob to the
right (clockwise), until you reach the optimal bal-
ance between broadband noise reduction and
introducing any unwanted artifacts.

16.  Slowly raise the Enhance slider to help add tonali-
ty and boost frequencies that are commonly lost in
degraded media sources (if you are working with a
recording made from a degraded media source).

17.  When you are satisfied with the results, close the
SoundSoap 2 interface and leave the insert active in
the Audio Mixer window.  Noise reduction settings
will be applied when you export the project from
Premiere Pro.

Conclusion

You should now be familiar with the “hands-on” aspects
of using SoundSoap 2 with a variety of other software.
We hope you enjoy using SoundSoap 2 for cleaning up
your noisy recordings and adding a professional touch to
your audio projects!
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